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2 Important notice

NXP provides the enclosed product(s) under the following conditions:

This evaluation kit is intended for use of ENGINEERING DEVELOPMENT OR
EVALUATION PURPOSES ONLY. It is provided as a sample IC pre-soldered to a
printed circuit board to make it easier to access inputs, outputs, and supply terminals.
This evaluation board may be used with any development system or other source of
I/O signals by simply connecting it to the host MCU or computer board via off-the-
shelf cables. This evaluation board is not a Reference Design and is not intended to
represent a final design recommendation for any particular application. Final device in
an application will be heavily dependent on proper printed circuit board layout and heat
sinking design as well as attention to supply filtering, transient suppression, and I/O
signal quality.

The goods provided may not be complete in terms of required design, marketing, and
or manufacturing related protective considerations, including product safety measures
typically found in the end product incorporating the goods. Due to the open construction
of the product, it is the user's responsibility to take any and all appropriate precautions
with regard to electrostatic discharge. In order to minimize risks associated with the
customers applications, adequate design and operating safeguards must be provided
by the customer to minimize inherent or procedural hazards. For any safety concerns,
contact NXP sales and technical support services.

Should this evaluation kit not meet the specifications indicated in the kit, it may be
returned within 30 days from the date of delivery and will be replaced by a new kit.

NXP reserves the right to make changes without further notice to any products herein.
NXP makes no warranty, representation or guarantee regarding the suitability of its
products for any particular purpose, nor does NXP assume any liability arising out of the
application or use of any product or circuit, and specifically disclaims any and all liability,
including without limitation consequential or incidental damages. “Typical” parameters
can and do vary in different applications and actual performance may vary over time.
All operating parameters, including “Typical”, must be validated for each customer
application by customer’s technical experts.

NXP does not convey any license under its patent rights nor the rights of others. NXP
products are not designed, intended, or authorized for use as components in systems
intended for surgical implant into the body, or other applications intended to support or
sustain life, or for any other application in which the failure of the NXP product could
create a situation where personal injury or death may occur.

Should the Buyer purchase or use NXP products for any such unintended or
unauthorized application, the Buyer shall indemnify and hold NXP and its officers,
employees, subsidiaries, affiliates, and distributors harmless against all claims, costs,
damages, and expenses, and reasonable attorney fees arising out of, directly or
indirectly, any claim of personal injury or death associated with such unintended or
unauthorized use, even if such claim alleges NXP was negligent regarding the design
or manufacture of the part. NXP and the NXP logo are trademarks of NXP B.V. All other
product or service names are the property of their respective owners. © 2016 NXP B.V.
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3 Overview

The FRDMPKPT2000EVM evaluation module provides a platform for developing and
testing automotive fuel-injection control systems based on NXP’s MC33PT2000 direct
injection pre-driver IC. The evaluation module consists of the FRDMPT2000EVM board
and a companion FRDMPK144-Q100 board.

The FRDMPT2000EVM contains an MC33PT2000 Programmable Solenoid Controller
(PSC) and provides connections for up to six fuel injectors, a fuel pump and a DC/
DC converter. The MCU used on the FRDMPK144-Q100 board is the S32K144, an
automotive Kinetis processor which offers the high-speed performance required to
evaluate PT2000 automotive fuel system designs. While the FRDMPK144-Q100 features
a range of capabilities, its primary purpose when used with the FRDMPKPT2000EVM is
to control SPI and digital I/O communications with the MC33PT2000.

The boards are attached by means of two parallel rows of single Arduino™ connectors
on the top (FRDMPK144-Q100) or bottom (FRDMPT2000EVM) of each board. In this
configuration the developer interacts with the MC33PT2000 by connecting a USB cable
between a USB port on a host PC and an OpenSDA USB port on the FRDMPK144-
Q100. NXP’s S32 Design Studio software serves as the platform for developing
application-specific microcode and downloading it to the FRDMPK144-Q100 through the
OpenSDA port. Alternatively, NXP's PT2000 Design Studio provides a software platform
for developing microcode for the FRDMPT2000EVM.

With the FRDMPKPT2000EVM in this configuration, the developer can run application
code but cannot directly access the registers and memory locations on the MC33PT2000
device. For developers who wish to read and write to device registers and memory during
the development process, an alternative configuration is available. By replacing the
FRDMPK144-Q100 with a FRDM-KL25Z board (sold separately), the developer can use
NXP’s SPIGen software to directly access the MC33PT2000 on the FRDMPT2000EVM
board. However, this configuration has limitations. The FRDM-KL25Z MCU is designed
for commercial use and may not be able to meet the performance demands of
automotive applications being evaluated in real time.
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4 Getting started

4.1 Kit contents/packing list
The FRDMPKPT2000EVM development kit contents includes:

• Assembled and tested FRDMPT2000EVM board mounted to a FRDMPK144-Q100
board in anti-static bag

• Quick start guide

4.2 Jump start
NXP’s analog product development boards provide an easy-to-use platform for
evaluating NXP products. The boards support a range of analog, mixed-signal and power
solutions. They incorporate monolithic ICs and system-in-package devices that use
proven high-volume technology. NXP products offer longer battery life, a smaller form
factor, reduced component counts, lower cost and improved performance in powering
state of the art systems.

1. Go to http://www.nxp.com/FRDMPKPT2000EVM.
2. Review your Tools Summary Page.
3. Locate and click:

 

 
4. Download the documents, software and other information.

Once the files are downloaded, review the user guide in the bundle. The user guide
includes setup instructions, BOM and schematics. Jump start bundles are available on
each tool summary page with the most relevant and current information. The information
includes everything needed for design.

4.3 Required equipment
This kit requires the following items:

• 1/8” blade screwdriver for connecting the loads
• DC Power supply: 12 V with minimum 5.0 A current handling capability, depending on

load requirements
• USB Standard A (male) to micro-B (male) cable (for included K144 Freedom board)
• USB Standard A (male) to mini-B (male) cable (for optional KL25Z Freedom board)
• Typical loads (direct injection fuel injectors)
• FRDM-KL25Z Freedom Development Platform for SPI communication (optional)
• NXP SPIGen software (for use with optional FRDM-KL25Z based SPI Dongle)
• NXP's S32 Design Studio software (for use with the FRDM-PK144-Q100)
• NXP's PT2000 Developer Studio (for use with the FRDM-PT2000-EVM)

http://www.nxp.com/FRDMPKPT2000EVM
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4.4 System requirements
The kit requires the following to function properly with the software:

• USB enabled computer running Windows 7 or newer
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5 Getting to know the hardware

The FRDMPKPT2000EVM consists of two boards: The FRDMPT2000EVM board and
an attached FRDMPK144-Q100 board. An optional FRDM-KL25Z (sold separately) may
also be used with the FRDMPT2000EVM. This section describes all three boards.

5.1 The FRDMPT2000EVM board

5.1.1 Board overview
The FRDMPKPT2000EVM serves as the interface between the MC33PT2000 and the
components it controls. The board contains a commercial version of the MC33PT2000
and connectors for up to six fuel injectors, a fuel pump and a DC/DC converter.

5.1.2 Board features
The board features are as follows:

• an MC33PT2000 direct injection pre-driver integrated circuit
• external MOSFETs
• power-conditioning circuitry
• +12 V to +36 V VSUPP power to the MC33PT2000
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5.1.3 Block diagram
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Figure 2. Block diagram

Note: The 9.0 V is regulator is optional and is used only to allow high voltage on the
battery without damaging the MCU. The PT2000 supports up to 72 V on the battery line,
but the reverse battery FETs are only rated to 40 V. Therefore, the board supply should
be limited to 36 V.
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5.1.4 Device features

Table 1. Device features
Device Description Features

MC33PT2000 Programmable Solenoid Controller, 5 high-sides
and 7 low-sides

• Battery voltage range, 5.5 V < VBATT < 32 V
• Pre-drive operating voltage up to 72 V
• High-side/low-side pre-drive PWM capability

up to 100 kHz
• Four selectable slew rates with all pre-drivers
• Eight selectable, pre-defined VDS monitoring

thresholds
• Encryption for microcode protection
• Integrated 1.0 MHz back-up clock

MCU S32K144 Microcontroller • 112 MHz ARM Cortex-M4 core with SFPU
• Modified Harvard architecture to support

tightly coupled RAM and 4 KB I/D cache
• Hardware security engine supporting SHE

specification
• 128-bit unique identification (UID) number per

chip
• Internal 48 MHz RC (IRC) oscillator
• Up to six FlexCAN, a maximum of two with

FD support
• FlexIO emulating communication protocols,

e.g. SPI, UART, etc.
• Supports ISO 26262 ASIL-B
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5.1.5 Board description
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Figure 3. Board description

Table 2. Board description
Number Name Description

1 MC33PT2000 Programmable solenoid controller

2 Pi filter Circuitry to remove undesired frequencies

3 DC/DC DC/DC converter to generate BOOST voltage

4 Fuel pump One high-side and one low-side control for high
pressure fuel pump

5 Injector Bank 1 Two high-side and two low-side controls for fuel
injectors 1 and 2

6 Injector Bank 2 Two high-side and two low-side controls for fuel
injectors 3 and 4

7 Injector Bank 3 Two high-side and two low-side controls for fuel
injectors 5 and 6
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5.1.6 Jumper definitions
Figure 4 shows the location of jumpers on the FRDM-PT2000-EVM board.

JVCCIO

aaa-025901

JVCC5

JCLK

Figure 4. Jumper locations

Table 3 describes the function of the board jumpers. The bold font in the Setting column
indicates the default setting.

Table 3. Jumper definitions
Jumper Description Setting Connection/Result

Connected Supplies VCC5 from the +5.0 V regulator on the
FRDMPK144-Q100JVCC5 VCC5_SEL

Not connected VCC5 must be supplied with +5.0 V from an external supply

Connected Supplies VCCIO from the +3.3 V regulator on the
FRDMPK144-Q100 (5.0 V logic)JVCCIO VCCIO_SEL

Not connected No voltage goes through the I/Os

Connected Sets the FRDMPK144-Q100 oscillator to 1.0 MHz
JCLK CLK_SEL

Not connected Uses internal 1.0 MHz backup CLK
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5.1.7 Test point definitions

aaa-025902

28

29

31
32

33

34

35

36

38

39

40

37

27 26 25 24

1 2

23

3 4 5 6 7

17
16

9 10 11

12

13

14
15

18192021

30

22

8

Figure 5. Test point locations

Table 4. Test points
Number Name Description

1 MISO SPI master in slave out

2 CSB SPI chip select

3 DBG I/O that can be configured to disable internal VCCP. Also
used by the KITPSCDEBUGEVM Tracer tool during power-
up.

4 VCC5 5.0 V VCC5 voltage

5 OA2 OA2 test point for current recopy or I/Os

6 OA1 OA1 test point for current recopy or I/Os

7 OA3 OA3 test point for current recopy or I/Os

8 GND Ground test point

9 VCCP VCCP voltage

10 VBAT Battery voltage

11 VBOOST Vboost voltage

12 G_LS8 Gate 8 low-side
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Number Name Description
13 G_HS7 Gate 7 high-side

14 G_LS7 Gate 7 low-side

15 GND Ground test point

16 VSENSSEN1 Negative current sense

17 VSENSEP1 Positive current sense used to monitor injector current

18 G_HS2 Gate 2 high-side

19 G_HS1 Gate 1 high-side

20 G_LS2 Gate 2 low-side

21 G_LS1 Gate 1 low-side

22 GND Ground test point

23 START6 Provides start signal for Injector 6

24 START4 Provides start signal for Injector 4

25 START2 Provides start signal for Injector 2

26 VCCIO I/O voltage set to 3.3V by default (JVCCIO)

27 IRQB Interrupt pin used to report fault to MCU

28 GND Ground test point

29 FLAG0 Flag pin used as input or output

30 FLAG1 Flag pin used as input or output

31 FLAG2 Flag pin used as input or output

32 FLAG3 Flag pin used as input or output

33 RSTB When the RESETB line is held low, the MC33PT2000 resets

34 START1 Provides start signal for Injector 1

35 START3 Provides start signal for Injector 3

36 START5 Provides start signal for Injector 5

37 START7 Provides start signal for fuel pump

38 MOSI SPI Master Out Slave In

39 SCLK SPI CLK up to 10MHz

40 GND Ground test point
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5.1.8 Connectors
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Figure 6. Connectors

Table 5. Input connectors
Name Description Connection

Screw terminal 1: 12 V to 36 V
JVSUPP Power supply input

Screw terminal 2: Ground

Table 6. Output connectors
Name Description Connection

Screw terminal 1: High-side drive
INJ1 Injector output 1

Screw terminal 2: Low-side drive

Screw terminal 1: High-side drive
INJ2 Injector output 2

Screw terminal 2: Low-side drive

Screw terminal 1: High-side drive
INJ3 Injector output 3

Screw terminal 2: Low-side drive

INJ4 Injector output 4 Screw terminal 1: High-side drive
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Name Description Connection
Screw terminal 2: Low-side drive

Screw terminal 1: High-side drive
INJ5 Injector output 5

Screw terminal 2: Low-side drive

Screw terminal 1: High-side drive
INJ6 Injector output 6

Screw terminal 2: Low-side drive

Screw terminal 1: High-side drive
FP1 Fuel pump output

Screw terminal 2: Low-side drive

5.2 The FRDMPK144-Q100 board
The FRDMPK144-Q100 features the MCU S32K144, an automotive Kinetis processor
which provides the high-speed performance required to evaluate MC33PT2000
automotive fuel system designs. While the FRDMPK144-Q100 offers a range of
capabilities, its primary purpose when used with the FRDMPKPT2000EVM is to control
SPI and digital I/O communications with the MC33PT2000.

In that context, two on-board switches (SW2 and SW3) allow developers to control the
MC33PT2000 when using the example projects provided on the FRDMPKPT2000EVM
Tool Summary Page. The board also includes a potentiometer for RPM control and three
LEDs that light to indicate when a MC33PT2000 fault occurs.

For additional information on this board, contact local support for the FRDMPK144-Q100
board.

aaa-025947

Figure 7. FRDMPK144-Q100
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5.3 The FRDM-KL25Z board
NXP’s Freedom development platform is a set of software and hardware tools that
provide an ideal platform for the rapid prototyping of microcontroller- based applications.
The FRDM-KL25Z board is a key component of the development platform.

The board features a Kinetis L Series microcontroller, the industry's first microcontroller
built on the ARM® Cortex™ –M0+ core. It makes use of the USB, the built in LEDs and
the I/O ports available with NXP’s Kinetis KL2x family of microcontrollers. When used
in conjunction with other Freedom evaluation boards, the FRDM-KL25Z controls SPI
communication between the evaluation board and a PC. It permits the user to regulate
the power outputs and implement the features of the device on the evaluation board.

The FRDM-KL25Z also monitors the SPI registers, thereby facilitating the use of safety
and advanced diagnostic functions.
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J1 I/O
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J2 I/O
Header

KL25Z
USB

Reset OpenSDA
USB

RGB
LED

aaa-024249

Figure 8. FRDM-KL25Z
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For additional information on the FRDM-KL25Z board, see the FRDM-KL25Z
User's Manual available here: http://www.nxp.com/products/software-and-
tools/hardware-development-tools/freedom-development-boards/freedom-
development-platform-for-kinetis-kl14-kl15-kl24-kl25-mcus:FRDM-KL25Z?
fpsp=1&tab=Documentation_Tab&lang_cd=en

http://www.nxp.com/products/software-and-tools/hardware-development-tools/freedom-development-boards/freedom-development-platform-for-kinetis-kl14-kl15-kl24-kl25-mcus:FRDM-KL25Z?fpsp=1&tab=Documentation_Tab&lang_cd=en
http://www.nxp.com/products/software-and-tools/hardware-development-tools/freedom-development-boards/freedom-development-platform-for-kinetis-kl14-kl15-kl24-kl25-mcus:FRDM-KL25Z?fpsp=1&tab=Documentation_Tab&lang_cd=en
http://www.nxp.com/products/software-and-tools/hardware-development-tools/freedom-development-boards/freedom-development-platform-for-kinetis-kl14-kl15-kl24-kl25-mcus:FRDM-KL25Z?fpsp=1&tab=Documentation_Tab&lang_cd=en
http://www.nxp.com/products/software-and-tools/hardware-development-tools/freedom-development-boards/freedom-development-platform-for-kinetis-kl14-kl15-kl24-kl25-mcus:FRDM-KL25Z?fpsp=1&tab=Documentation_Tab&lang_cd=en
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6 Operating the FRDMPKPT2000EVM with the FRDMPK144-Q100

The FRDMPKPT2000EVM ships with a FRDMPK144-Q100 board attached via Arduino™

connectors to the bottom side of the FRDMPT2000EVM board. In this configuration,
the MC33PT2000 functionality can only be exercised by downloading the appropriate
microcode to the device.

6.1 Configuring the hardware for use with the FRDMPKPT2000EVM
1. Connect the micro-B plug on the USB cable to the USB port on the FRDMPK144-

Q100 board. Connect the USB cable’s Standard A plug to the host PC. An icon
named EVB-S32K144 appears as a removable drive on the host PC.
 

aaa-025994

 
2. With the power supply switched off, attach the +12 VDC supply to the VSUPP

input connector on the FRDMPT2000EVM board. Make sure that the power supply
is connected to the correct GND and +12 V terminals on the board. The current
capability of the +12 V supply must exceed the maximum total current required by the
number of loads that can be simultaneously ON.

3. Attach loads (Injectors) to the INJ1, INJ2, INJ3, INJ4, INJ5 and INJ6 output terminals
as desired.

4. Turn on the +12 V supply. The +5.0 V LED illuminates, indicating that the board is
properly connected.

6.2 Downloading microcode
To use the FRDMPKPT2000EVM in a development environment, the developer must
install an NXP Integrated Design Environment (IDE) to download and run microcode. The
procedure for downloading microcode differs depending on whether the microcode is
being downloaded to the FRDMPK144-Q100 or to the FRDMPT2000EVM.
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6.2.1 Downloading microcode to the FRDMPK144-Q100
The procedure for downloading microcode to the S32K144 device on the FRDMPK144-
Q100 consist of the following steps

1. Installing NXP's S32 Design Studio
2. Downloading the FRDMPK144-Q100 example project file
3. Importing the example project file into S32 Design Studio
4. Customizing (optional) and building the example project file firmware image
5. Downloading the firmware image to the FRDMPK144-Q100

The following sections describe each of these steps in detail

6.2.1.1 Installing S32 Design Studio

NXP’s S32 Design Studio allows developers to customize the FRDMPK144-Q100's
MCU code to meet application-specific requirements. The S32 Design Studio IDE is
a complimentary integrated development environment that enables editing, compiling
and debugging of automotive and ultra-reliable designs. Based on free, open-source
software including Eclipse IDE, GNU Compiler Collection (GCC) and GNU Debugger
(GDB), the S32 Design Studio IDE is a straightforward development tool with no code-
size limitations.

This procedure explains how to obtain and install the latest version of S32 Design Studio.
If S32 Design Studio is already installed on the host PC, skip this section.

1. Obtain the latest S32 Design Studio installer file from the NXP website http://
www.nxp.com/S32DS.

2. Run the executable file and follow the instructions.

The S32 Design Studio SDK library is distributed with the IDE already integrated, so no
explicit action is required to add or link it manually.

6.2.1.2 Downloading the FRDMPK144-Q100 example file

The Jump Start package on the FRDMPKPT2000EVM Tool Summary Page contains
an example microcode project file. This project demonstrates a typical application that
exercises the functionality of the fuel injectors and the fuel pump controllers. Developers
can download this file and edit the source code to accommodate their application.

To download the example file, do the following:

1. Go to the Tool Summary Page at http://www.nxp.com/FRDMPKPT2000EVM and click
on the Jump Start icon.

2. Locate and download the zip file named S32K144_PT2000_EXAMPLE.zip.
3. Unzip this file into a folder on the computer that has the S32 Design Studio installed

6.2.1.3 Importing the example file

Once the demo file has been downloaded, the developer must import it into S32 Design
Studio. The procedure is as follows:

1. Open S32 Design Studio
2. From the S32 Design Studio menu bar, click File->Import. A Select window opens.
3. In the Select window, expand the folder named General. Then select Existing

Projects into Workspace and click Next. An Import Projects window opens.

http://www.nxp.com/S32DS
http://www.nxp.com/S32DS
http://www.nxp.com/FRDMPKPT2000EVM
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4. In the Import Project window, browse for and select the root directory containing the
example file. In the Projects panel, select the example file. Then click Finish. See
Figure 9.

aaa-025992

Figure 9. Import Projects dialog

The example file appears in the Project Explorer panel on the left side of the IDE.

6.2.1.4 Customizing and building the example file

Developers can flash the MCU on the FRDMK144-Q100 with the unmodified example file
microcode if they so desire. They may also choose to modify the source code to meet the
specific requirements of their application. In either case, the project must be built in S32
Design Studio before downloading the microcode.

1. To customize the example file, expand the example project tree in the Project
Explorer window to view the file folders. The source code is located in the src folder
and the include files are located in the include folder. Double-clicking the file name in
the Project Explorer will open the file for editing where changes can be made.

2. To build the project, select the project in the Project Explorer window, then click on the
hammer icon on the S32 Design Studio toolbar. If there are no errors during the build,
the output file will be located in the Debug folder under the main project folder. The
file will have a .srec extension (example: S32K144_PT2000_EXAMPLE.srec).
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Figure 10. S32 Design Studio build project

6.2.1.5 Downloading the firmware to the FRDMPK144-Q100

1. Connect the micro-B plug on the USB cable to the USB port on the FRDMPK144-
Q100 board. Connect the USB cable’s Standard A plug to the host PC. An icon
named EVB-S32K144 appears as a removable drive on the host PC.

2. To download the firmware, locate the firmware file
(S32K144_PT2000_EXAMPLE.srec) on your computer and drag and drop the file
onto the EVB-S32K144 icon.

The firmware program begins running immediately after the download has completed.

6.2.2 Updating microcode on the FRDMPT2000EVM
This section provides an overview of the process for updating the microcode on the
FRDMPT2000EVM. For in depth information on the process, refer to the MC33PT2000
Developer Studio User’s Guide (PT2000_IDEUG). In general, the procedure consist of
the following steps:

1. Installing NXP’s PT2000 Developer Studio
2. Loading, building and regenerating the example projects
3. Updating the FRDMPK144-Q100 with the new project data

6.2.2.1 Installing PT2000 Developer Studio

1. Obtain the latest version of the PT2000 Developer Studio installer file from the
NXP website: http://www.nxp.com/products/power-management/engine-and-dc-

http://www.nxp.com/products/power-management/engine-and-dc-motor-control/powertrain-engine-control/developer-studio-for-pt2000-programmable-solenoid-controller:PT2000IDE?tab=Design_Tools_Tab
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motor-control/powertrain-engine-control/developer-studio-for-pt2000-programmable-
solenoid-controller:PT2000IDE?tab=Design_Tools_Tab.

2. Run the executable file and follow the Wizard instructions.

6.2.2.2 Loading, building and regenerating the example projects

Two relevant example projects—FRDMPKPT2000EVM Software Files for Peak and
Hold with Diagnostics and DCDC and FRDMPKPT2000EVM Software Files for
Peak and Hold and DCDC—are available on the FRDMPKPT2000EVM Tool Summary
Page. These examples can be used as starting points for developing application specific
microcode. For information on how to load and build projects using the IDE, refer to the
MC33PT2000 Developer Studio User’s Guide which can be accessed using the Help
menu on the IDE.

After successfully building a project, the PT2000 load data files must be regenerated. To
do this,

• In the MC33PT2000 Developer Studio toolbar, select Tools->Generate MC33PT2000
Load Data Code. When the regeneration process completes, the Code Generation
Results window will appear as shown in Figure 11.

aaa-025995

Figure 11. Code Generation Results

6.2.2.3 Updating the FRDMPK144-Q100

1. In Windows Explorer, open the folder that the generated code files were saved to.
Locate the files PT2000_LoadData.h and PT2000_LoadData.c (usually found in
the folder named sample_code). These files contain the code RAM, data RAM,
and register settings that get loaded into the PT2000. The MC33PT2000 Developer
Studio also creates other files that may be useful when creating a new MCU project
from scratch. See the MC33PT2000 Developer Studio User’s Guide, available here
http://www.nxp.com/assets/documents/data/en/user-guides/PT2000-IDEUG.pdf?
fsrch=1&sr=1&pageNum=1, for a description of these files and how they are used.

2. To update the S32 design studio project, copy PT2000_LoadData.c over the
existing file in the src folder of the S32 Design Studio project, and copy the
PT2000_LoadData.h file over the existing file in the include folder.

3. To run the updated microcode on the EVB, rebuild the project and reload the
FRDMPK144-Q100 board as described in Section 6.2.2.2 "Loading, building and
regenerating the example projects".

http://www.nxp.com/products/power-management/engine-and-dc-motor-control/powertrain-engine-control/developer-studio-for-pt2000-programmable-solenoid-controller:PT2000IDE?tab=Design_Tools_Tab
http://www.nxp.com/products/power-management/engine-and-dc-motor-control/powertrain-engine-control/developer-studio-for-pt2000-programmable-solenoid-controller:PT2000IDE?tab=Design_Tools_Tab
http://www.nxp.com/assets/documents/data/en/user-guides/PT2000-IDEUG.pdf?fsrch=1&sr=1&pageNum=1
http://www.nxp.com/assets/documents/data/en/user-guides/PT2000-IDEUG.pdf?fsrch=1&sr=1&pageNum=1
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7 Operating the FRDMPKPT2000EVM with SPIGen and the FRDM-KL25Z

In its out-of-the-box configuration, the FRDMPKPT2000EVM’s MC33PT2000 device can
only be exercised by downloading the appropriate microcode. To access the device’s
registers and internal memory, the developer must replace the FRDMPK144-Q100 with
a FRDM-KL25Z board. With the FRDM-KL25Z serving as an SPI dongle, the developer
can then use NXP’s SPIGen software to communicate with the device.

7.1 Preparing to use the FRDM-KL25Z
Before the FRDM-KL25Z can be used in conjunction with FRDMPT2000EVM board, the
following steps must be taken:

1. Install SPIGen on the host PC
2. Download microcode to the FRDM-KL25Z
3. Connect the FRDM-KL25Z to the FRDMPT2000EVM board

The following sections describe each step in detail.

7.1.1 Installing SPIGen on the host PC
SPIGen currently runs on Windows 7, Windows 8 and Windows 10 operating systems.
The procedure for installing the software is as follows:

1. Go to the FRDMPKPT2000EVM Tool Summary Page at www.nxp.com/
FRDMPKPT2000EVM and locate the Jump Start Your Design section.

2. From the list of files, download the SPIGen software as well as the associated
configuration files.

3. Run the install program from the desktop. Follow the guidance of the installation
wizard through the rest of the process.

7.1.2 Connecting the FRDM-KL25Z to the FRDMPT2000EVM
When connected to the FRDMPT2000EVM board, the FRDM-KL25Z allows developers
to drive the evaluation board inputs to operate injectors or other solenoid loads via
the GPIOs and SPI pins. The FRDM-KL25Z can also read and write the SPI registers,
thereby allowing the user to modify parameters on the PT2000 and us the advanced
diagnostic functions.

The procedure for configuring the FRDMPT2000EVM for use with the FRDM-KL25Z is as
follows:

1. Detach the FRDMPK144-Q100 from the FRDMPT2000-EVM board.
2. Place connectors blocks on the outer rows of all four Arduino connectors on the

FRDM-KL25Z.
3. Attach the FRDM-KL25Z to the underside of the FRDMPT2000EVM board such that

connector J3 on the FRDMPT2000EVM aligns with connector J9 on the FRDM-KL25Z
and connector J2 on the FRDMPT2000EVM aligns with connector J2 on the FRDM-
KL25Z.
 

http://www.nxp.com/FRDMPKPT2000EVM
http://www.nxp.com/FRDMPKPT2000EVM
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4. Connect the Standard-A plug of the USB cable to the host PC. Connect the mini-B

plug on the cable to the port labeled USBKL25Z on the FRDM-KL25Z.

7.1.3 Downloading microcode to the FRDM-KL25Z
Note that this procedure requires a Standard-A (male) to mini-B (male) USB cable.

1. Go to the P & E Microcomputer Systems OpenSDA page at http://www.pemicro.com/
opensda and in the OpenSDA Firmware (MSD & Debug) box, click to download the
Firmware Apps zip file.
 

http://www.pemicro.com/opensda
http://www.pemicro.com/opensda
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2. When the download completes, unzip the file contents to a folder on the host PC.
3. Connect the Standard A plug of the USB cable to the host PC.
4. On the FRDM-KL25Z, press and hold down the Reset button. With the button

held down, attach the mini-B plug of the USB cable to the FRDM-KL25Z USB port
labeled SDA. Then release the Reset button. A blinking LED indicates the board is in
Bootloader mode.

5. Open Windows Explorer on the host PC. An icon labeled BOOTLOADER appears as
a removable drive on the PC.

6. From the files extracted from the PEMicro zip file, locate the driver file named
MSDDEBUG- FRDM-KL25Z_Pemicro_v118.SDA. Drag and drop this file onto the
BOOTLOADER icon.

7. Unplug the USB mini-B plug then re-insert the plug back into the SDA port. A blinking
LED on the board indicates that the FRDM-KL43Z is in bootload mode.

8. Locate the SPIGEN UsbSpiDongleKL25Zv507.srec image folder in the SPIGEN
folder (C:\Program Files (x86)\SPIGen\SPI Dongle Firmware).

9. Copy and paste or drag and drop the .srec file to the FRDM-KL25Z removable drive
icon on the host PC.

10.Unplug the USB cable from the FRDM-KL25Z SDA port.

7.2 Configuring the hardware for use with the FRDM-KL25Z
To run the examples included in the software bundle, the following connections and
setup must be performed:

1. Make sure SPIGen 7.0 (or higher) is installed on the PC and it can communicate with
the Freedom board KL25Z. A blue LED lights on the FRDM-KL25Z when SPIGen is
running and the board is properly connected.

2. Connect the KL25Z to the PC using the USB KL25Z port (left side of SW1). The
USB_PWR LED on the FRDMPT2000EVM should be illuminated.

3. With the power supply switched off, attach the +12 VDC supply to the VSUPP input
connector on the FRDMPT2000EVM. Make sure that the power supply is connected
to the correct GND and +12 V terminals on the board. The current capability of the
+12 V supply must exceed the maximum total current required by the number of loads
that can be simultaneously ON.
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4. Attach loads (Injectors) to the INJ1, INJ2, INJ3, INJ4, INJ5 and INJ6 output terminals
as desired.

5. Turn on the +12 V supply. The +5.0 V LED illuminates, indicating that the board is
properly connected.

7.3 Using SPIGen

7.3.1 Configuring the SPIGen software
1. In the Windows Start menu, go to Programs->SPIGen and click on the SPIGen icon.

This icon will appear on the Windows desktop if the appropriate option ws selected
during installation.

2. When the SPIGen Graphical User Interface (GUI) appears, go to the the file menu in
the upper left corner and select Open. A file selection window opens. In the bottom
right corner of the window, the dropdown box value should be set to SPIGen Files
(*.spi). If the configuration file name has a .txt extension, set this value to All Files
(*.*).

3. Browse for the SPIGen configuration file downloaded from the Tool Summary Page
(see Section 7.1.1 "Installing SPIGen on the host PC").
Select the configuration file and click Open. SPIGen creates an SPI command
generator configured specifically for the FRDMPT2000EVM board.

The GUI is shown in Figure 16. The text at the top is the name of the configuration
file that is loaded. The left side panel displays folders that group user interfaces.
The interfaces in the pre-installed MC33PT2000 folder pertain specifically to the
board FRDMPT2000EVM. When the configuration file loads, SPIGen is assigned a
FRDMPT2000EVM-specific list of Extra Pins and Quick Commands.
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Figure 12. SPIGen PT2000 Microcode User Interface

7.3.2 Running an example file
1. With the FRDMPT2000EVM and FRDM-KL25Z configures as described in Section

7.2 "Configuring the hardware for use with the FRDM-KL25Z ", launch the SPIGen
program.

2. Load the configuration file, by clicking File->Open and browsing to the
KITPT2000SW.spi file located inside the Injector Demo Files directory.

3. In the Device View panel, expand the PT2000 folder and click on Micro Code.
4. In the SPIGen menu bar, click on Files->Open and select the

SPIGenMC33PT2000Files.txt included in the project example. All cells in the
Micro Code page (Code Ramx, Data Ramx, Channelx, Main, IO, and Diagnostics
Configuration Registers) should populate with the appropriate path.

5. Click the Reset, Download and Enable button to load and enable the PT2000.
6. In the Start Pulse Width (ms) cell, select the appropriate duration.
7. In the Device View panel, in the PT2000 folder and click on Channel Config. Select

Channel 1.
a. Check to assure that flash enable is selected in the Register: cell.
b. Click on the Read button and assure that the checksum failure bit is not set.
c. Assure that Bits 3, 4 and 5 are set as shown below.
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8. Repeat the Channel Config process for Channel 2 and Channel 3.

7.3.3 Running the example batch files
1. In the Device View panel, expand the Generic folder and click on Batch

Commands. There are five choices. The Start1 through Start3 options pulse a single
injector only (Injector 1, 2 or 3, respectively). The Start1-3 batch command pulses all
three injectors in sequence.

2. Click on the Send Continuously button.
3. Notice that the three loads attached to the FRDMPT2000EVM board are turning on

and off in succession.

7.3.4 Reading and writing registers
SPIGen can also be used to read and write the registers on the PT2000. There a four
different register configuration pages under the PT2000 Device View:

• Channel Configuration
• Main Configuration
• IO Configuration
• Diagnosis Configuration

The Channel Configuration register page covers all three channels and is shown in
Figure 13.
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Figure 13. PT2000 channel configuration register page

To read or write a specific register on the PT2000, select the register name from the
Register drop down on the top center of the page. The register address will be shown to
the right of the name. To read the contents of the register, click on the Read button. The
bits that are set (1) are colored blue; the bits that are cleared (0) are colored white.

To write to a specific register, click on the bits to be changed to set them to the proper
state Then click the Write button. The read and write process is the same for the other
register groups which can be accessed by clicking on the register group name under
PT2000 in the Device View window.
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8 Schematics, board layout and bill of materials

FRDMPKPT2000EVM board schematics, board layout and bill of materials are available
in the Jump Start section of the Tool summary page at the following URL: http://
www.nxp.com/%0AFRDMPKPT2000EVM

9 Revision history
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1.0 12/2016 Initial release
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11 Legal information

11.1  Definitions
Draft — The document is a draft version only. The content is still under
internal review and subject to formal approval, which may result in
modifications or additions. NXP Semiconductors does not give any
representations or warranties as to the accuracy or completeness of
information included herein and shall have no liability for the consequences
of use of such information.

11.2  Disclaimers
Information in this document is provided solely to enable system and
software implementers to use NXP products. There are no express or
implied copyright licenses granted hereunder to design or fabricate any
integrated circuits based on the information in this document. NXP reserves
the right to make changes without further notice to any products herein.

NXP makes no warranty, representation, or guarantee regarding the
suitability of its products for any particular purpose, nor does NXP assume
any liability arising out of the application or use of any product or circuit,

and specifically disclaims any and all liability, including without limitation
consequential or incidental damages. “Typical” parameters that may be
provided in NXP data sheets and/ or specifications can and do vary in
different applications, and actual performance may vary over time. All
operating parameters, including “typicals,” must be validated for each
customer application by customer's technical experts. NXP does not
convey any license under its patent rights nor the rights of others. NXP sells
products pursuant to standard terms and conditions of sale, which can be
found at the following address: nxp.com/salestermsandconditions.

11.3  Trademarks
Notice: All referenced brands, product names, service names and
trademarks are the property of their respective owners.

NXP — is a trademark of NXP B.V.
the NXP logo — is a trademark of NXP B.V.
Freescale — is a trademark of NXP B.V.
the Freescale logo — is a trademark of NXP B.V.
SMARTMOS — is a trademark of NXP B.V.
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